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COPYRIGHT NOTICE 
 

This manual and the software that it describes are the property of Interpex Limited.  The 

purchaser is licensed to use this copy of IXVLF on one computer only.  One working copy 

of the software may be made by the purchaser for his own use.  One hard copy of the 

manual may also be made for the purchaser's own use. 

 

The purchaser is hereby granted permission to excerpt text from this manual for the 

purposes of inclusion in reports to the purchaser's clients, when results from this 

software package are included in said report and this manual is referenced as the source. 

 

No part of this document may be stored in a retrieval system, transmitted or reproduced 

in any way, including but not limited to photocopy, photograph, magnetic or other 

mechanical or electrical means, for any purpose, in whole or in part, without the express 

written permission of Interpex Limited. 

 

DISCLAIMER 
 

It is the user's responsibility to be sure that the interpretations derived from the use of 

this software are accurate and correct.  Although Interpex Limited has done its best to 

make sure that this manual and the software package which it describes are free from 

errors, Interpex does not assume any responsibility for results obtained using this 

software. 

 

 

Copyright © 2007 Interpex Ltd.,  

PO Box 839, Golden, Colorado, 80402.  

All rights reserved.  World rights reserved.   

 

All tables and screen reproductions are from IXVLF by Interpex Limited.   

 

AutoCAD is a trademark of Autodesk, Inc. 

IXVLF is a trademark of Interpex Limited. 

18 October 2007  

 

 

 Interpex Limited 

 P.O. Box 839 - Golden, Colorado  80402 

 Tel: (303) 278-9124 

 Fax: (303) 278-4007 
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ABOUT THIS MANUAL 

 

This manual is a PDF version of the Windows Help file that comes with IXVLF. It was 

created by importing the Windows Help pages into Microsoft Word and importing the 

pictures separately, with some additional formatting. 

 

The purpose of this manual is to offer an alternative medium to the Windows Help, and 

especially one that can be easily printed in its entirety so that it can be read in 

circumstances where a computer is not relatively available or being used for some other 

task. 

 

Please contact Interpex Limited by e-mail at info@interpex.com if you have any concerns 

about possible errors or omissions in this manual. 
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Overview 
 
IXVLF is a software package for the viewing of VLF survey data in terms of plan view contour 
maps, line drawn profiles and Hjelt depth sections. Data are stored on a regular grid, so that 
stations exist across lines even if they do not contain data. The grid elements do not have to be 
regular, so that lines can be more closely spaced in one section than in others, and stations can 
be more closely spaced in some sections than others. However, each line contains the same 
number and values of stations. 
 
For updates, go to http://www.interpex.com/IXVLF/IXVLFversion.htm 
 
IXVLF has the following features: 
 

• Imports VLF data from ABEM WADI, Scintrex, Scintrex XYZ++, IRIS and flat ASCII data 
formats. 

• Imports data from ASCII XYZ files. 

• Imports data from EMIX VLF binary VLX files. 

• Appends data from  ABEM WADI, Scintrex, Scintrex XYZ++, IRIS, flat ASCII and ASCII 
XYZ files 

• Allows for creating data with manual entry or copy/paste from spreadsheets (like Excel). 

• No limit on number of lines or stations. 

• Exports Magnetic Field, Fraser filter results, Hjelt filter results, Tilt angle/Ellipticity or Field 
strength data to XYZ files. 

• Exports graphics to DXF, CGM or WMF formats. 

• Data can be imported, exported edited or viewed as In-Phase and Quadrature or Tilt 
Angle/Ellipticity. 

• Map view shows data with contours, color fill, station positions, all under user control. 

• Profile view shows one or more profiles or a single Hjelt depth section display. 

• Hjelt depth section display shows contours, color fill, depth positions, all under user 
control. 

 
Processing flow: 
 

1. Import Data using File/Import to import VLF data. File/Append can be used later to 
append data to an existing data set. 

 
2. Save the data. 

 
3. Work with the data by displaying different quantities/components on the map, view 

selected profiles and select profiles for Hjelt depth section displays until you understand 
the data and know what you want to show. 

 
4. Use the Mouse to add and edit labels on the displays. See Adding and Modifying 

Labels for more detail. 
 

5. Save the data when you have established a set of displays. 
 

6. Create printed or graphic file outputs for final presentation. 
 
All profile data and results are saved to a binary file in Interpex IXVLF format using the File/ 

command . File/Save As allows the data and results to be saved under a new name and 

File/Open  is used to retrieve the results. When IXVLF is started, the last file used is 
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automatically opened and any profiles or Hjelt depth sections that were displayed when the 
project was saved are reinstated. 
 
Graphics can be exported in three different formats, AutoCAD DXF, CGM, or Windows Metafile 
WMF formats. 
 
Export DXF graphics file allows you to enter a file name for an AutoCAD DXF interchange file. 
Then a DXF file is created with the same graphics as is presented in the graphics window on the 
screen. 
 
Export CGM graphics file allows you to enter a file name for a CGM interchange file. Then a CGM 
file is created with the same graphics as is presented in the graphics window on the screen. 
 
Export WMF graphics file allows you to enter a file name for a WMF interchange file. Then a 
WMF file is created with the same graphics as is presented in the graphics window on the screen. 
 
Any of the graphics windows can be printed using File/Print from the appropriate window. 
 
The graphics view can be adjusted and selected using the options in the View menu. 
 
IXVLF does not have full capabilities unless it is registered to a user or a particular computer, 
fitted with a hardware key or used with keyed demo data files.  
 
Hardware key is fitted to the parallel or USB port. 

Installing and Updating IXVLF 

 
IXVLF is installed by running the setup file found on the distribution CD or downloaded from the 
Interpex web site. Usually it is installed into C:\Program files\IXVLF. The executable file is called 
IXVLF .exe. 
 
After installing, use Windows Explorer to open the C:\Program files\IXVLF directory and drag the 
IXVLF .exe from there to the desktop using the RIGHT mouse button. When released, select 
"Create shortcut here". Position the shortcut according to your preferences and rename it to 
IXVLF . 
 
If you have selected "Hide extensions for known file types" in Tools/folder options/view in the 
Windows Explorer, the EXE extension will not be shown. It will be the file with the InterpeX "IX" 
logo and the Hjelt depth section on top of it.  
 

 
 
Right-click on the shortcut and select properties. Change the "Start in:" field to the location where 
you will be storing your VLF data files. IXVLF remembers which directory you last used and takes 
you back there, but if it forgets now you will at least start in a reasonable place. 
 
To update IXVLF to a new version, download the zip file containing the updates from 
www.interpex.com and unzip that file into the C:\Program files\IXVLF directory. you need WinZip 
to do this. You can find WinZip at www.winzip.com. If you want to save your present version (just 
to be safe), rename it to include the version, for instance IXVLF 101 for version1.01. 
 
The Help file for IXVLF is in the C:\Program files\IXVLF directory. You can access it through 
Help/Contents in IXVLF or you can drag it onto the desktop using the RIGHT mouse button and 
create a shortcut just as you did for the executable. 
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There is a tutorial for using IXVLF on the Interpex web site under tutorials. It is a PowerPoint PPS 
file. You can download that and keep it in the C:\Program files\IXVLF directory with the software 
and create a shortcut to that on your desktop as you did for the program and help files. 
 
Check the Interpex web site periodically for updates, particularly if you are having problems. 
Always run the most recent version before reporting any problems with the software. 
 
 
 
 

References 

 
Ogilvy,R.D and Lee, A.C. 1991. Interpretation of  VLF-Em in-phase data using current density 

pseudosections. Geophysical prospecting 39, 567-580. 
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Associating files with IXVLF 

 
If you associate IXV files with IXVLF in Windows Explorer, you can double click on files of type 
IXV and it will execute IXVLF, opening that file. 
 
Note: This works only with registered versions. 
 
The installation procedure should have already done this, but if it hasn't, then this is how to do it. 
 
To do this, open Windows Explorer, and select Tools/folder Options...: 
 

 
 
Next, select the File types tab: 
 

 
 
Now press the New button: 
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Enter the extension IXV and press OK: 
 

 
 
Next, press the change button to change the program that opens this file: 
 

 
 
Use the Select the program from a list option: 
 

 
 
If you see the program IXVLF, select it and press OK. If not, press the Browse button: 
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Browse will start in C:\Program Files. If it does not, go there. Look for the IXVLF directory and 
open that. Find IXVLF.exe and open that: 
 

 
 
Now double clicking on a file of type IXV will open IXVLF with that file. 
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File/New Menu 
 
To clear existing data in IXVLF use File/New/Clear Data: 
 

 
 
You will be asked to confirm the clear: 
 

 
 
Press OK to proceed and clear data, Cancel to abort clearing the data. 
 
To enter data manually and create a new survey, use File/New/Survey. You will be prompted  
 

 
 
Press OK to clear the data and proceed, Cancel to abort creating a new survey. 
 
Note that there is a sequence of steps and if any of them are cancelled, all data entered to that 
point will be lost. 
 
The next step is to enter the new survey parameters: 
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Stations and lines are assumed to be evenly spaced, but this can be changed later. The survey is 
defined as consisting of a number of lines and a number of stations per line, so the data are laid 
out on a regular rectangular grid. Specify the number of lines and number of stations per line and 
the beginning value and increment for each. 
 
Specify the default frequency for each line. This can be changed later. 
 
If the lines run from south to north (that is, lines are 100E, 200E, etc.) check the "Lines run South 
to North" box. 
 
If you are entering the tilt angle and ellpticity, rather than in-phase and quadrature magnetic 
fields, check the "Data are Tilt Angle, Ellipticity" box. 
 
Press OK to proceed, Cancel to abort survey creation. 
 

 
 
Next you will see the spreadsheet with lines, stations and frequencies. You can edit these if you 
wish. If they are correct, press OK. You can cancel the survey creation by pressing Cancel. 
 
Next you will enter the in-phase (or tilt angle) data. The spreadsheet will start out blank. You can 
type the numbers or copy/paste them from a spreadsheet, like Excel. 
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Following this you will enter the quadrature (or ellipticity) data. Last you will enter the field 
strength data. 
 
Note that if any cells contain an unknown value (missing station), just leave it blank. 
 
Also note that all data are stored as in-phase and quadrature; if you enter tilt angle and ellipticity, 
these data will be converted to in-phase and quadrature: 
 
InPhase=100.*TAN(TiltAngle) 
Quadrature=100*Ellipticity 
 
Data can still be displayed as either type. 
 
When the field strength data have been entered, press OK to display the data. 
 

Open, Save, Save As 
 
IXVLF saves its data and results in a proprietary binary format. This format is designed to be 
forward and backwards compatible, so that files written by older versions of the software can be 
read by newer versions of the software and vice-versa. 
 
Binary files created with File/Save and File/Save As can be read using File/Open and carry the 
extension IXV 
 
Binary files are designed to be forward and backward compatible. That is to say that newer 
versions of IXVLF can read files created by an older version and older versions of IXVLF can 
read files created by a newer version. Obviously, if the file created by a newer version contains 
additional data about which the older version knows nothing, it will be skipped. 
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 Importing and Appending Data from ASCII and other files 

 
The File/Import menu contains options to import VLF data, either to replace existing data or to 
append to existing data. 
 
The only difference between importing and appending topographic data is whether or not any 
existing data are discarded before import. Append is not available with EMIXVLF files. 
 
You cannot append data that has the lines running in a different direction. 
 
As data are imported, they are sorted into the correct order in ascending station or line 
coordinate. 
 
Select File/Import/ASCII Data File/VLF Data to import data from a flat ASCII file. In this format, no 
LINE keywords or header information will be read. 
 
Select File/Import/ASCII Data File/ABEM WADI VLF Data to import data from a file created by the 
ABEM WADI software. You will only be asked for a file name and the data will be read. 
 
Select File/Import/ASCII Data File/Scintrex VLF Data to import data from a file created from the 
Scintrex OMNI instrument. 
 
Select File/Import/ASCII Data File/Scintrex XYZ++ VLF Data to import data from a file created 
from the instruments in XYZ++ format. 
 
Select File/Import/ASCII Data File/IRIS VLF Data to import data from a file created from the IRIS 
T-VLF instrument. 
 
Select File/Import/XYZ Data File to import data from a file in the (Geosoft) XYZ format. 
 
Select File/Import/EMIXVLF Binary Data File to import data from a file created by Interpex 
EMIXVLF DOS software. 
 
To append data (except from EMIXVLF format), use File/Append instead of File/Import. 
 
The first dialog which is presented upon invocation of the File/Import/ASCII Data File/ VLF Data 
or  File/Import/XYZ Data File is a dialog asking if you are importing in-phase and quadrature or tilt 
angle and ellipticity data: 
 

 
 
Select which type of data you are importing. Next comes the file selection dialog, followed by a 
dialog which allows you to select the rows where the data you are reading will reside: 
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This dialog will be displayed for all imports except for the ABEM Wadi and EMIXVLF binary file 
import. 
 
For Scintrex or IRIS formats, IXVLF uses a predetermined set of columns as specified by the 
instrument manufacturer. Edits to these columns will only be retained during the current IXVLF 
session. Columns can be separated by blanks, tabs or commas. Multiple commas, blanks or tabs 
are treated as a single comma, blank or tabs. 
 
For Flat ASCII files, the line column is required. Line values are taken from the line column. When 
ASCII files are appended to the currently loaded data set, station values that are not coincident 
with the current spacing of the existing data can be moved to coincide with the existing grid. 
Otherwise, grids can be very dense but sparsely populated and many displays will not work 
properly. 
 
For XYZ and other files, the line position is determined from records with the LINE keyword. W 
and S are converted to negative values, E and N stay as positive. If N, S , E or W are not present, 
you will be prompted for the line direction. 
 
If there is no field strength, enter 0 for the field strength column. For most files, the column for 
frequency will also be 0. If the Select Freq. is greater than 0, this will be set as the frequency for 
all lines. 
 
If the lines or stations are not set to the real values but divided by some factor, you can enter a 
factor different from 1. 
 
Once you press OK, the file is read and the data should be displayed. Press Cancel to abort the 
import. 
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Export Menu 

 
The File/Export menu allows for the export of data to XYZ style files or for export of graphics. 
 

 
 
Currently supported graphics files are AutoCAD DXF, CGM and WMF formats. In whichever 
window it is invoked, it will export that graphic to the selected format. 
 
XYZ files can be created for the Magnetic Field, Fraser or Hjelt filter output, Tilt Angle and 
Ellipticity as well as field strength. 
 
After selecting the field for export, a dialog appears. For Magnetic Field, Fraser or Hjelt output, 
the dialog offers the following: 
 

 
 
For tilt angle and ellipticity, it offers the following: 
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Next the file menu appears. Enter or select the file name and the file will be written out. 
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Editing the Data 

 
Selecting the Edit menu brings up a number of options: 
 

 
 
This allows you to edit the Station Locations, Magnetic field data, Tilt angle/ellipticity data or the 
field strength. 
 
Selecting Station Locations brings up the station location editor: 
 

 
 
This does not allow you to delete or create additional lines or stations, but it allows you to edit the 
present values. Stations or lines which are nonexistent are grayed out (read only). 
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You can edit the data set name. Press OK to accept edits, Cancel to cancel the edits and return 
to the main menu. 
 
Selecting any of the other options brings up a generic editor containing the selected data: 
 

 
 
Unknown values are shown as blank cells. Deleting a value will set it to unknown. Use the scroll 
bars to scroll the display as needed. 
 
The line and station values cannot be edited in this dialog. 
 
To finish press OK to accept edits, Cancel to cancel the edits and return to the main menu. 
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View Menu 

 
The View menu in the main IXVLF window allows for adjustment and selection of the graphics 
display as follows: 
 

Zoom  toggles the zoom capability on and off. When selected, depressing the left mouse 
button and dragging it across the display creates a rubber-band box. When the mouse button is 
released, the selected graphic is rescaled according to the dimensions of the box, rather than to 
the min and max of the data values themselves. When more than one graphic is displayed, the 
graphic containing the center of the box is rescaled. In this case, the horizontal axis of both 
graphs are simultaneously rescaled. The box can be smaller or larger than the original display. 
 

Unzoom  autoscales the graphic displays to the min and max of the data displayed. 
 

Last Zoom  restores the graphic display to the state it was in before the last time the Zoom or 
UnZoom command was used. 
 
Stations is checked if View/Stations is turned on. In this case each station on the map will be 
indicated by a box. The color of the box will indicate the value of the point in question. 
 
Magnetic Field, Fraser Filter, Hjelt Filter, Tilt Angle, Ellipticity and Field Strength represent a 
group of which only one will be checked. This controls the particular field being displayed on the 
map (and on the profile display, if shown). This can also be selected in the Map View Parameters 
dialog, discussed below. 
 
For Magnetic Field, Fraser Filter and Hjelt Filter, the group In-Phase, Quadrature and 
Amplitude control which component of the data is displayed. Again, only one of these items will 
be checked, so checking one will uncheck the others.  This can also be selected in the Map View 
Parameters dialog, discussed below. 
 

Map View Parameters or pressing  will bring up a dialog of parameters for the map view: 
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The top two groups of radio buttons duplicates the functionality of the menu items discussed 
above. Some of the check boxes do as well. In addition there are several additional options: 
 
Reverse Color Fill Sequence changes the color fill from normal (red to blue as numbers 
increase) to reverse (blue to red as numbers increase). 
 
Run Filters Backwards will start the filtering on the end (highest station value) and work towards 
the beginning for Fraser and Hjelt filters. 
 
Draw Stacked Profiles will draw a profile along each line, seismic trace style: 
 

 
 
Fill Stacked Profiles will fill the positive portions of the stacked profiles, seismic trace style. If 
Draw Stacked Profiles is not selected, the fill is also disabled: 
 

 
 
Label Data Type above Map will label the type of data: 
 



IXVLF Manual    Page 21 of 35 

 

 
 
Color Stations to Value turns on and off the coloring of the boxes indicating station or Hjelt 
depth positions. 
 
Color Contours to Value turns on and off the coloring of the contour lines to the value of the 
contour. 
 
Depth for Hjelt Contours controls the depth value which is displayed when Hjelt dept section 
values are displayed on the map. 
 
Display Type can be Contours Only, Contour Fill Only, Contour Fill w/Contours, Color Fill 
Only or Color Fill w/Contours. Contour fill is a separate color for each contour interval. Color fill 
is a continuous gradation from red to blue (or blue to red). 
 
Press OK to accept the changes, Cancel to abort the edit. 
 
View/Grid has two options: 
 

 
 
Major grid lines are drawn at labeled major tick marks on the graph. Minor grid lines are drawn at 
minor, unlabeled tick marks on the graph. Turning on minor grid lines also turns on major grid 
lines. Turning off major grid lines turns off minor as well. 
 
View/Properties is discussed in detail in a different section and it controls the labels and details 
for the individual axes as well as the range of velocities for color fill and the arc length for the arcs 
on the depth and elevation sections. 
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View Properties 

 

View/Properties  gives the user to details of the axes used to display the map, profiles, depth 
section and range of colors used for color fill. The dialog you see depends on the window you are 
in when you bring up View Properties. 
 
For the Map window, the dialog is for the Easting and Northing axes: 
 

 
 
The tab control in the dialog allows for tabbing between the two axes which are used in the 
current display. Otherwise, the tabs look very similar, so we will discuss only the Northing tab. 
 
The Northing axis label can be edited and it is stored in the IXVLF.INI file so it pertains to all data 
sets accessed, not only to the particular data set being worked on when changes are made. It is 
important to preserve the units for this label: "(m"). Otherwise the label can be translated to 
another language or modified to suit the user's purpose. 
 
The radio buttons near the lower left corner control whether the cm or inches areas of the dialog 
are active. 
 
The label height field controls the height of the label on the axis and the offset controls the offset 
towards graph. These give the user control over the appearance of the labels. 
 
For each axis, the axes are specified by the number of major divisions, the starting value and the 
number of major divisions. The number of minor divisions can also be changed. 
 
The velocity color fill range can also be specified and this normally goes from red to blue. If you 
check Reverse Color Sequence, the color fill will be from blue to red. 
 
The color fill range depends on the type of data being viewed. There are separate ranges for 
Magnetic Field, Tilt Angle, Ellipticity, Fraser Filter and Hjelt Filter. 
 
The line width allows for heavier lines on printed graphs.  
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Out of range colors can be saturated or white. For example if the color range is from -100 to 100 
and red to blue, a value of -120 would be red and a value of 120 would be blue if the Saturated 
box is checked. If it is not checked, they would be white (not shown). Unknown values are never 
shown. 
 
For the Hjelt depth window, the dialog is very similar, except the Northing (or Easting, depending 
on the line direction) and Hjelt Depth tabs are displayed The color fill range is that for the Hjelt 
depth. 
 
For the Profile window, the dialog is also similar, except the Northing (or Easting, depending on 
the line direction) and field tabs are displayed The color fill range is that for data displayed on the 
map. 
 

Edit Line Colors 

 

View/Edit Line Colors allows the user to specify the colors used to draw lines on the graphics. 
The dialog allows for the editing of the color of the Axes, Stations, Labels and Stacked Profiles: 

  

To edit the color, press the down arrow and select the color from the drop down box. Press OK to 
accept edits, Cancel to cancel edits. 

 

Autoscale Fill Colors 

 

View/Autoscale Fill Colors allows the user to automatically find a reasonable set of min and 
max values for the color fill. First the data are examined and outlier values are discarded before 
being scanned for min and max values. The min and max values can be edited in 
View/Properties. 
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The Profile Window 

 
Clicking on a station (left click) toggles the display of that profile on the profile display. One, 
several or all profiles can be selected for display. Changing the data type displayed on the map 
also changes the data type displayed on the profile display: 
 

 
 
The file menu on the profile display allows for exporting and printing of graphics: 
 

 
 
Also the window can be closed py selecting Exit. 
 
The View menu on the profile display allows for zooming, auto-scaling display of labels (or not), 
grid line control and Properties: 
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Selecting Help will bring up this page in the Help file. 
 
Profile lines are added or removed by clicking on the profile in the map display. 
 
As you move the mouse cursor around on the display, the first two elements of the status bar will 
show the station and the field value. When you point the cursor at a point on a profile, it will also 
show the line and station for that point: 
 

 
 
Clicking the mouse will remove that line from the profile display. 
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The Hjelt Depth Section Window 
 
Right-Clicking on a station and selecting Hjelt Depth will display that line in the Hjelt Depth 
Section display: 
 

 
 
If the display already exists, the data currently shown will be replaced by that for the newly 
selected line. If not, the window is created. 
 
The file menu on the profile display allows for exporting the depth section and for the exporting 
and printing of graphics: 
 

 
 
Also the window can be closed by selecting Exit. 
 
Selecting File/Export/Hjelt Depth Section brings up a dialog: 
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This allows for one or more components to be exported to the same XYZ file. Press OK to 
proceed to the file selection menu. After selecting a file, the data will be written to that file as 
station, depth and selected Hjelt components for the line being viewed. 
 
The View menu on the profile display allows for zooming, auto-scaling, display of labels (or not), 
display of depth points (or not), grid line control, Hjelt View Parameters and Properties: 
 

 
 
If the Labels menu item is checked, any labels which have been created for this display will be 
shown. 
 
If Depth Points is checked, the individual depth points calculated for this line will be shown. 
 
Selecting Hjelt View Parameters will bring up a dialog: 
 



IXVLF Manual    Page 28 of 35 

 

 
 
This allows you to select the displayed component, display type and a number of other options. 
 
Show Depth Points duplicates the menu functionality.  
Reverse Color Fill Sequence changes blue to red to red to blue. 
Run filters backwards makes the Hjelt and Fraser filters run in reverse. 
Label data type above graph shows data type next to data set name. 
Depth points and contour values can be drawn in a single color or color coded to their value. 
 
NOTE: If color fill is used as well as color coding, the depth points or contours may be difficult to 
see. 
 
Selecting Help will bring up this page in the Help file. 
 
As you move the mouse cursor around on the display, the first two elements of the status bar will 
show the station and the depth value. 
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Using the Mouse on the Map, Profile and Depth Section Displays 

 
The mouse can be used to determine the properties of data and to toggle the display of profile 
lines. It can also be used to change the profile displayed in the Hjelt depth section. 
 
As the mouse is moved within the graph, the x- and y-position of the cursor is displayed in the 
first two sections of the status bar at the bottom of the window. The data value at the cursor is 
shown in the third section: 
 

 
 
In the map display, when you point the mouse at a station, the cursor turns into a crosshair and 
the station number and value,. line number and value and data value are shown in sections 3-5 of 
the status bar: 
 

 
 
When not pointing at a station, the interpolated field value is shown. 
 
Pointing at a station and (left) clicking the mouse toggles the display of that line on the profile 
display. If the profile display window does not exist, it is created. If the profile is displayed, it is 
removed. If not, it is added to the display. 
 
Pointing at a station and right-clicking the mouse brings up a menu offering several options: 
 

 
 
Selecting Toggle Profile has the same effect as left clicking as described above. 
 
Selecting Hjelt Depth will display the Hjelt depth section for this profile. If a profile is already 
displayed, this will replace the display with the new profile. If not, the window and display is 
created. 
 
Selecting New Label will bring up the label entry dialog: 
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Please see Adding and Modifying Labels for more details on label manipulation. 
 
Selecting Properties will bring up the View Properties dialog. See View Properties for more 
details. 
 
Left-clicking in the data graph without pointing at a station brings up a menu allowing you to 
change the display properties or parameters (see View Menu for more details) and to add a label 
to the display: 
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Adding and Modifying Labels 

 
Labels can be added to any of the displays. Labels are deleted when a new project is created by 
importing (not appending) data or if the Edit/Delete Labels command is used. 
 
To add a label, right click while not pointing at anything and select New Label from the pop-up 
menu: 
 

 
 
Next you will be asked to enter label text. There is a maximum of 50 characters: 
 

 
 
Labels are separate for the Map, Profile and Hjelt depth section displays. Labels on the Map and 
Profile displays are separate for the Magnetic field, Fraser filter, Hjelt filter, tilt angle ellipticity and 
field strength displays. They are not separate for the in-phase, quadrature, amplitude or phase 
displays. 
 
When you point at the label with the mouse, the label will "light up" and a box will be drawn 
around the label area. Pointing at a corner or side will change the cursor to an arrow that allows 
you to drag that corner or side by depressing the left mouse button and dragging the corner or 
side. 
 
Pointing at the arrow tip or center of the label will change the cursor to a 4-way arrow that allows 
you to move the arrow or label. 
 
The picture shows several of the options for moving and resizing: 
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Right clicking on the label will allow you to edit the label, delete the label, add an arrow or delete 
the arrow. Adding an arrow when the arrow already exists will reset the existing arrow to the 
default position. 
 

 
 
NOTE: You are not asked to confirm the deletion of the label or arrow. 
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Help Contents 

 
The Help Contents command displays this help file and allows the user to read it using the 
Microsoft Help System. 
 

Help can be requested by selecting Help/Contents or pressing the help toolbar button . 
 
If Help is requested from the main window, the Help Contents is shown, positioned at the very 
beginning. 
 
If Help is requested from another window, the Help Topic for the section pertaining to that window 
is shown. However, the entire help file contents are still available by pressing the Help Topics 
button. 
 

 

Register 

 
IXVLF is copy protected using your user name and password. However, in certain instances, 
copy protection can also be done by registering to a CPU. This is normally done if a University 
needs additional keys for use in a student computer laboratory environment. 
 
Using Help/Register brings up the following dialog: 
 

 
 
Interpex will furnish a registration code to go with your user name upon payment of the license 
fee. In the installation directory (normally C:\Program Files\IXVLF) you will find a form 
ORDER.TXT. Please use this form to order a license by FAXing it to Interpex. 
 
The user name must be the name of the person or company registering the license. It will be 
shown on all screen displays and printed on all output. 
 
An alternative means of registering is to a CPU. These licenses are normally for use in a student 
computer lab, for instance. In this case, using Help/Register to CPU brings up the following 
dialog: 
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The program code is calculated by IXVLF using information pertaining to the serial number of 
your computer and is unique to each machine. If you want the access key, you must furnish the 
program code to Interpex. Upon payment of the license fee or upon agreement with Interpex, you 
will receive an access key from Interpex. 
 
The "Your Name" field can be used to identify your output. This would be your company name, or 
in the case of a student computer lab, the name of the student using the software at the moment. 
Each student should start a session by registering so that his or her name would appear on all 
printouts created during that session. 
 

 

About IXVLF 

 
Help About displays the version and the date of the IXVLF software package, gives a brief 
description of what it does, displays the copyright notice and gives the phone number, fax number 
and e-mail address for Interpex. 
 
If a hardware key is connected, it also gives the serial number of the hardware key. 
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